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Copyright Notice
You may not reproduce, transmit, transcribe, store in a retrieval system or translate into any
human or computer language this manual and software. These actions, in any form or by
any means, are illegal without the express written permission of Puritas Springs Software.

Disclaimer & Limitations
Puritas Springs Software provides Wrongful Death & Minor’s Claims, consisting of both
the software and this manual, "AS IS." The software and manual carry no warranty as to
performance, merchantability or fitness for any particular use. Puritas Springs Software
specifically disclaims all warranties, express or implied, regarding the software or our services, and Puritas Springs Software does not warrant that the software or services are
free from defects, interruption, errors or other program limitations. For states containing limitations on implied warranties, any such implied warranties are limited to 60 days from the
date of purchase. The rights provided by the purchase of this software shall be limited to the
original, registered and recorded purchaser. Said rights are limited to the cost of the software and are non-transferable. You assume all liability and responsibility for the accuracy of
any form produced by this software. Recognizing this, Puritas Springs Software has exercised due care in the preparation of the software and manual. In no event, however, shall
the authors or publisher be liable for direct, incidental or consequential damages, or damages of any type, arising from the use of Wrongful Death & Minor’s Claims.
This Agreement sets forth Puritas Springs Software’s entire liability and your exclusive
rights and remedy with respect to the software. Headings are included for convenience and
shall not be considered in interpreting this Agreement. This Agreement does not limit any
rights that Puritas Springs Software may have under trade secret, copyright, patent or
other laws, federal or state.
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Wrongful Death & Minors Claims - Version
5 (WMinor5) is a 32-bit application that was
designed to run in either Windows or OSX for
Apple/Mac.
System Requirements. WMinor5 requires a
Pentium or equivalent processor with at least
32 MB of RAM. WMinor5 is provided to
purchasers as a downloadable executable of
approximately 8 megabytes. WMinor5 works
best on a computer that is equipped with a SVGA video card capable of minimum
resolution of 800 x 600 with a minimum of 256 colors and a compatible printer.
Higher resolutions and color depth are recommended.
WARNING: United States Copyright laws protect WMinor5 as the property of Puritas Springs Software. WMinor5 contains a registered serial number that is located in various places within the software. Possessors of unauthorized copies violate Federal law.
Note that the files on the Puritas Springs disks are compressed. You cannot copy
them to your hard drive manually. You must "install" them using the SETUP application.
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Installing
WMinor5
Overview
You install Minor Claims & Wrongful
Death—Version 5 (WMinor5) to your computer by simply running the setupwminor5.exe
file from our web server. You are always assigned a password for that purpose although
passwords expire after a period of time. You will be assigned a new password if you
need to reinstall the software and Version 5 is the current version at that time. Although the installation process is automatic, you can follow the steps on the next
page just to make sure that the installation moving along smoothly.
NOTE ABOUT RUNNING APPLICATIONS: Many of the installation problems
we encounter in technical support are the result of the user running programs in the
background during installation. When you install WMinor5, you should make sure
there are no applications running. Therefore, there should be no application buttons
on the task bar. If you’re unsure how to check what’s running, we recommend rebooting your computer and doing the install right after you’ve rebooted and before
you run any other application. Note that some applications execute automatically on
startup, these too should be terminated before beginning the install. You may want
to ask someone to help on this very important step if you’re unsure about how to
check for running applications.

Network Installations & Licensing
In the case of network installations, the types and implementations are diverse and
we cannot give network-specific technical support although we answer questions
about WMinor5 to assist network administrators during installation and setup. Note
that you must have a network license to be able to install WMinor5 for use on a network.

Windows Installation Steps
A. The Preparing to Install screen will appear briefly as InstallShield sets itself up
to begin the installation process. Typically, you’ll see a progress meter until the
Welcome dialog appears. Click the Next button to proceed with installation.
Click Cancel if you want to abort installation.
B. The Puritas Springs Software Licensing Agreement appears in the next dialog. Click on the I accept ... option to accept the terms and conditions of the
license, and then click on the Next button to continue with the installation. If
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you do not agree to the terms of the Licensing Agreement, you will not be able to
continue installing the program.
C. Verify your user identification information and click the Next button. Unless you
have a compelling reason to do otherwise, leave the Anyone who uses this computer option selected.
D. You will now see the Ready to Install dialog. Click the Install button to begin
the actual installation process. As files are copied and installation tasks are completed by the InstallShield Wizard, a progress meter will keep you informed as the
stages of installation are completed.
E. On some systems you may be asked to confirm the installation directory. By default the location is C:\Program Files\Puritas\WMinor5. We recommend leaving the default location in place and do not support installations to alternate locations.
F. On some systems you may be asked to confirm the database directory. The
“database” is the location where your client files will be kept. By default the location is C:\Puritas\WMinor5\Files. We recommend leaving the default location in
place and do not support installations to alternate locations unless you have purchased the network or multi-user version of WMinor5.
G. When installation is complete a Installation Wizard Completed dialog appears
on the screen and you can click the Finish button.

Running The Program
When installation is complete, a WMinor5 icon is placed on your desktop. You can
start the program by clicking on the icon. You can also run the program in the conventional manner by clicking on the Start button in the lower, left corner of your
screen, then click the Programs or All Programs item, then the Puritas Springs
Software submenu, and finally click on the WMinor5 item.
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When you start Wrongful Death and Minor's Claims (WMinor5), you see the
Main Window. The Main Window gives
you access to a blank client probate form
set (blank except for any information present in the DEFAULT file). In particular,
you see the General Information Worksheet because it is the logical starting place.
Regardless, you can display and complete any form or worksheet in any order.

The <TAB> Key v
Use the <TAB> vkey to move from field to field. When you press the vkey, focus
moves from field to field allowing you to complete the return. It’s also very helpful to
know that <SHIFT><TAB> moves backwards from field to field. This is especially
handy when you’ve overshot your destination field and wish to go back without cycling through all the fields on the page.

Other Notes
As you complete the various forms, you won't go too far before you notice that you
cannot tab to every field. WMinor5 calculates many answers based on information
you entered on the worksheets. The name of the estate and case number are good examples. When you enter them on the General Information Worksheet, they appear
automatically on all the other forms and schedules.
This is also true for financial information. You enter data such as settlement proceeds
and expenses in the Accounting Worksheet, and the relevant figures appear automatically on the desired forms. Spouses, children, parents and are handled similarly.
You enter all related information in the Kin/Claimant Worksheet and their names
and addresses appear automatically on the designated forms.
You’ll find that you can enter information in any order you want, but we've found
that developing a pattern of data entry procedures works best — that pattern is set out
in the tree view of the Main Window. We recommend following those steps.
This tutorial uses a minor's automobile accident injury claim as an example. This tutorial takes you keystroke by keystroke through the steps required to complete a minor's automobile accident injury claim from beginning to end. Note that the tutorial
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follows a file on your disk named SAMPLE.WM5. If you simply wish to follow the
tutorial without doing the typing, you can load the SAMPLE file and continue reading this tutorial.

Step 1. Complete the General Information Worksheet.
When you first start WMinor5 or select the File|New command, you get a blank set
of probate forms on which to begin working. The logical place to begin working is
the General Information Worksheet. This is where you'll enter common information like the name of the estate and the case number. Once entered on the General
Information Worksheet this information appears automatically on all the other probate forms.
Let's start! The cursor is blinking in the "Name of Estate" field. Type "Robert T
Sample" and then press the <TAB> vkey. Pressing the vkey takes you to the next
field—"Judge/Subtitle." In that field type: "Presiding Judge Philip T. Law" Note that
not all counties use a subtitle line, so if your county doesn’t, you should leave this
field blank. Complete the rest of the General Information Worksheet as shown below. Remember to press vto move from field to field.
Field
Probate Judge
County
Case No
Decedent/Injured Minor:

Answer
Philip T. Law
Cuyahoga
09-765432
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Name
Date of Death/Injury
Street Address
Post Office
City
County
State
Zip Code
Date of birth
Attorney:
Name
Address
(Address line 2)
Phone No.
Sup Ct No
Applicant/Fiduciary:
Name
Street Address
(Address line 2)
Phone No
Title
Co-Applicant/Co-Fiduciary:
Name
Street Address
(Address line 2)
Phone No
Title

Susan R. Sample
December 7, 2009
1234 Main Street
skip this field by pressing <TAB>
Cleveland
Cuyahoga
Ohio
44111
July 4, 2001
Ward F. Stone
17140 Lorain Avenue
Cleveland, Ohio 44111
216-251-5555
1234567
James T Sample
1234 Main Street
Cleveland, Ohio 44111
330-278-3252
Father
Judy S Sample
1234 Main Street
Cleveland, Ohio 44111
330-278-3252
Mother

After you press v on the last field, your screen should jump back to the top. It
should look similar to the one shown on the preceding page

Step 2. Name and Save Your File.
Up to this time the title bar at the top of the WMinor5 window tells you that this
new file has no name. Having completed the General Information Worksheet, you
should save your work by using the File|Save As command. Do this by clicking on
the File menu and then selecting the Save As item. When you are asked for a file
name, use any legitimate name. Keep in mind the following prohibitions about files
and their names:
1

Do not change WMinor5’s default WM5 extension. In other words, if you're
using intending to use the name "Jones," just type JONES and don't use a period
or alternate text after the period.

2

Save your WM5 files in the default directory (C:\Puritas\WMinor5\Files).
When there is a problem or confusion regarding saving files, it is usually related
to not following our admonition about using the default directory for your WM5
files.

Step 3. Enter all spouse, children, parent, next of kin survivor and claimant information in the Kin/Survivor/
Claimant Worksheet.
You can display the Kin Worksheet by pressing bK, or you can display the Kin
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Worksheet by going to the Display menu, open the Worksheets submenu and select Kin. The Sample file that is included with WMinor5 has various individuals
entered into the worksheet, however, when you start your own file the worksheet is
empty and ready to accept your first entry.


When the worksheet appears, the focus should be in the left-most, high-lighted
Name field.



Press v to move to the next field — Address. The next few fields are shown
below. To follow the Sample, you would complete the five fields as follows:
Name:
Address:
City/State/ZIP
Relationship:
Date of Birth:

Mary S Sample
1234 Main St
Cleveland, Ohio 44111
Mother
9/10/58

As usual you use the v key to move from line to line. Of course, you could also
click your mouse no the desired line and start typing.


When you're finished with the fifth line (Date of Birth), press v to move to the
radio button group box (Wrongful Death). This set of buttons is only used if the
case is a wrongful death case. It contains a list of checkboxes for those forms to
which you'd like the individual's name/address info to go. In the Sample we
skipped this column.



Click your mouse or press vto move to the next field or column (Minor's
Claims). This column is only used if the case is a minor's claim. It contains a
single checkbox for Form 22.1 – Waiver & Consent. In the Sample file we
checked this box.



Click your mouse or press vto move to the last column - Amount. Enter
$150,000.00. Note it is not necessary to enter the dollar sign ($) or comma (,).

Kin/Claimant Worksheet after first entry.
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You are done with the first entry in the Next of Kin Worksheet., click the Save to
Table button under the Amount field and your information will appear as the first
record in the table. Your worksheet screen should look like the illustration at the bottom of the preceding page.
To add additional kin, click the Add at End button. You will see a new blank record
at the end of the table. You can not complete the new entry using the top portion of
the worksheet screen. Enter the remaining parent as shown in the Sample file, we
will omit the entry-by-entry descriptions used for the first entry.
Final Notes About the Worksheet:
There should never be blank entry in the table, and WMinor5 is designed to automatically remove accidental blank rows in the table.
There are more entries in the SAMPLE file but you should have the hang of it by
now so that it is not necessary for us to go through each entry. If you wanted to continue following along in the Sample you could open the Sample and print the Kin/
Claimant Worksheet by clicking File|Print|Worksheets|Kin/Claimant. Before we
leave, however, there are several things to emphasize. These points apply to all three
of the database worksheets, not just the Kin/Claimant Worksheet.


You can only enter and modify information on the top part of the screen. The
bottom part of the screen, as explained below, is for navigation, sorting, and
viewing multiple rows at the same time.



When you're done entering or modifying a record, send your information back to
the table below by clicking the Save To Table button. You can also use the
<ENTER> key for this purpose. Clicking this button takes the information on
the top part of the screen and moves it to the currently selected row in the table
on the bottom half of the screen.



You can navigate, view multiple records, sort the table, and select a record for
editing on the bottom part of the screen -- the part that looks like a spreadsheet.



Almost every function in the worksheet can be implemented using hot keys.
There is a right-click, popup menu that has all the commands along with the hot
key combinations.



Each of the columns in the worksheet can be resized by dragging and sliding the
dividing bars between columns to the left to make a column smaller and to the
right to make a column wider. This allows you to customize the worksheet for
your particular computer monitor and screen resolution. WMinor5 remembers
your settings.



The entire table can be sorted by most of the available columns by simply clicking your mouse on the column title. the sorted column has a caret mark (^) next
to the column title.
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Step 4. Enter all financial information in the Accounting
Worksheet.
To enter financial information such as settlement offers, expenses or disbursements,
go to the Display menu, open the Worksheets submenu and select Accounting.
You can also display the Accounting Worksheet by pressing bE. Like the Kin/
Claimant Worksheet, when the Accounting Worksheet appears on your screen it
is blank and ready to accept your first entry. We will enter the settlement offer first.


When the worksheet appears, the focus should be in the left-most Description
field. Here you can enter:
Imprudential Insurance Company
Note that you may use carriage returns in your description if you wish to insert
hard line breaks. You can also type complete descriptive paragraphs, WMinor5
will automatically reformat your text so that it fits in the allotted space on the
chosen form. Click on the Ok button to close the mini editor.



Press v to move to the next set of fields (Wrongful Death). This group is only
used if the case is a wrongful death case. It contains a list of wrongful-deathrelated classifications from which you can pick. In the Sample we skipped this
column.



Press v to move to the next set of fields (Minor's Claims). This column is only
used if the case is a minor's claim. It contains a list of minor-claim-related classifications from which you can pick. In the Sample we picked Settlement Offer
for our first entry.



Finally, press v to move to the Amount field. Enter $750,000.00. Note that it is
not necessary to enter the dollar sign ($) or comma (,). In fact, WMinor5 will not
let you.

You are done with the first accounting entry. You do not have to save worksheet information because the worksheets save themselves automatically.
To add additional expenses, click the Add at End button. You will get a new blank
record at the end of the table.
Enter the additional expenses as shown in the Sample file, we will omit the entryby-entry descriptions used for the first expense. You can enter expenses in any order, but when they are displayed or printed out, like expenses will be grouped together, ie., all physician's expenses listed together.
There are more entries in the SAMPLE file and it would serve no purpose to go
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through each entry. The method for adding entries is the same as described above. If
you wanted additional fodder for practice, load the SAMPLE file and print the Accounting Worksheet to use as a guide for making additional entries. Before we
leave, however, there are several things to emphasize.
The illustration below shows what your screen should look like when you complete
the first record.

Top portion of Accounting Worksheet after first entry

Step 5. Enter all attorney time and services related to the
case in the Time & Services Worksheet.
The purpose of the Time & Services Worksheet is to give you a place to record
your legal services rendered in connection with the handling of the estate or claim.
You display the Time & Services Worksheet by pressing bB. When the worksheet appears on your screen it is blank and ready to accept your first entry. It is
much like the two worksheets we’ve just covered. In fact, it's more like the Accounting Worksheet in that it has a Description field in which you can enter descriptions of services regardless of length. Risking redundancy, here's an entry from
the Sample file.


When the worksheet appears, the focus should be in the left-most, high-lighted
Date field. In the Time & Services Worksheet all entries are sorted chronologically. Like the Date of Birth field in the Kin Worksheet, you can pull down
the calendar and pick your date. Clicking on the month at the top of the calendar
lets you jump to other months, and it's the same with the year.



Press v to move to the next field (Time Spent). Here you enter the time spent
in fractions of hours. For example, one hour would be entered as 1; one and a
half hours would be 1.5.



Finally, press v to move to the Rate field. Here you enter the hourly rate to be
applied to that service. We entered $150.00 in the Sample file. Note that it is
not necessary to enter the dollar sign ($) or comma (,). In fact, WMinor5 will not
let you. WMinor5 will also complete this field automatically based on your last
entry. This way if the hourly rate doesn't change, you don't need to keep reentering the hourly rate.
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Press v to move to the next field or column — Description. Here you can enter:
Initial office consultation with Mr. & Mrs. Sample; visit the scene of the
automobile accident of 7/4/2003 at the intersection of West 223rd St and
Liberty in North Ridgeville, Ohio.
Note that you may use carriage returns in your description if you wish to insert
hard line breaks. You can also type complete descriptive paragraphs, WMinor5
will automatically reformat your text so that it fits in the allotted space on the
chosen form.

You are done with the first time and services entry. Click the Save to Table button
to complete your first record or row in the table.
To add additional service records, click the Add at End button on the Navigator
bar. You will get a new blank record or row. It will jump into proper chronological
order after you enter the date and click on the Save to Table button.
Enter the additional items as shown in the Sample file, we will omit the entry-byentry descriptions used for the first item. You can enter items in any order.
You may find it convenient to set the hourly rate so that it populates each new row
automatically and you don’t need to enter it manually. You can do that on the Options menu using the Set Default Hourly Rate item.

Step 6. Review the required forms and add any remaining
information necessary for their completion.
In our minor claim example, we are using Forms 22.0 through 22.4. This step involves going to the Display menu, then to the Minor's Claim submenu and, one-byone, selecting and completing the Form 22 set.
Beginning with Form 22.0 - Application to Settle a Minor's Claim, you'll notice
when you display it that the caption and other information is already complete. The
focus is on the first check box in the group. Place a check in this box and then press
v.
Skip the next four check boxes by pressing v. Then check the sixth box, press v,
and enter "full and final" in the space before the word "settlement." Next press v
and enter the case number. Press v again.
Place a check in the "The proffered settlement … " check box. Then press v.
Place checks in the boxes for the medical expenses and attorney fees provisions.
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It shouldn't be necessary to take you through each entry. Simply tab from entry to
entry on a form and completing those areas that need to be completed. Answers that
are the basis of calculations or information transferred from other areas appears and
blue. You cannot tab to these fields. If you need to change an answer in blue you
must go to the worksheet where that information comes from. When you've tabbed
from the last entry on a page, it jumps back to the top of the page and you know
you've cycled through all the fields.
When you complete Form 22.0, you go to the Display menu and select Form 22.1.
Complete Form 22.1 by tabbing through each entry and completing those that need
to be completed. It may also be appropriate to complete the List of Medical Expenses, Attorney's Retainer Agreement and List of Suit Expenses. If you display
these forms you'll see there's very little, if anything, for you enter. These forms complete themselves based on your worksheet entries. One thing to remember is to save
your file periodically. We try to remember to press the Save button on the button
bar (underneath the menu bar) after we finish every page.
Hint: You can check or uncheck a box from the keyboard by pressing the space bar.
If your hands are already on the keyboard, it's easier to complete check boxes that
reaching for the mouse and clicking.

Step 7. Print the various required forms using the
File|Print|Selected Forms dialog.
When you're satisfied that the required forms are ready for filing, click the Selected
Forms item on the File menu's Print submenu. When the dialog appears, it will permit you to select those forms that you'd like to print. In the event a form has continuation pages (i.e., List of Medical Expenses and Proposed Payees), the entire set of that form will be printed. Further along on the Print menu there are items
for printing individual forms or just the front or back side of a two-sided form. There
is also the Print This Form button on the button bar. The hints will let you know
what button it is - it has a graphic of a printer.

Selected Forms Dialog
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Step 8. Optional. Send any form or forms to your word
processor using the File|Send to Word Processor|Selected Forms dialog.
It’s not necessary to send your forms to your word processor, but here are some reasons why you might want to.







You have problems printing straight from WMinor5.
You want or need to access exotic printer capabilities such as duplex printing, or
non-sequential page printing.
You want to email your forms
You want to make pdf files of your forms
You’d like to spell check the content of your forms
You’d like to grammar check the content of your forms

The send function works best with Microsoft’s Word. If you don’t have Word, try
Wordpad, but you’ll need to set your page margins one time. Try top, left and right
margins of 0.50” and a bottom margin of 0.25” for starters. Any other word processor must be capable of reading rtf files. Some don’t and those that do often make file
conversion mistakes making them problematic at best.
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This paper manual is merely an outline of the basics of installation, getting started
and a tutorial on basic information entry. You can get additional help via the program’s Help|Table of Contents menu. This program has context-sensitive help.
That means that you get help on a specific menu item without searching for that topic.
Simply highlight the menu command and press l. Many other objects on your
screen have associated help topics, i.e., window scaling. When in doubt, move focus
to the component object and press l .
The mouse won’t work to highlight a menu command. You must use the keyboard.
To give an example, if you wanted help with the Save As command you would press
aF to pull down the File menu, and use the arrow keys to highlight the Save As
command. With the command highlighted press the l key.
If you’re like us, you might be doubtful as to whether help files can be truly helpful.
Regardless of any drawbacks, we found them to have significant benefits over their
paper counterpart.
Help Is Always There
When we were at the office, the manual was at home. When were on the computer at
home, the manual was at the office. On unfortunate occasions, that alone can make
you lose a day. It never happens with help files. They’re always there. A copy for
your home computer, and a separate one for the office. Ditto for your laptop! When
you’re desperate for information, you can always count on its accessibility.
Help Is Hyperlinked, Searchable & Better Indexed.
We took extra time to develop a logical system of indexing. You should find that a
help file’s searchability can be a time-saver when you’re looking for a snatch of text.
The point and click links between key words provide instant information without
fumbling though page after page looking for something. This non-linear characteristic is part of what makes help files so uniquely useful.
Help Is Up To Date
Because they are printed in large quantities, paper manuals fall out of synch with lastminute or late-minor programming changes. Help files, on the other hand, are easier
to keep current with programming changes because their modification involves no
additional processing steps to implement (i.e., physical transportation, printing, binding, etc.).
Paper Fix
Don’t forget that you can print any help topic by pressing the help window’s Print
button, or using the menu’s Print Topic command.
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Checking out these help topics before starting WMinor5 will reduce the slope of the learning curve. Although WMinor5 relatively straightforward to use,
you’ll find that once you’ve mastered the database
worksheets, you’ve learned not just this but all of our
programs. This is because almost all of our programs
use the worksheets to minimize data entry.

1. What are the worksheets used for?
There are three database worksheets (not to be confused with the General Information
Worksheet). One of the three is the Accounting Worksheet. It is the central area
where WMinor5 keeps financial information. This short topic describes how to enter
information into and use the worksheets. A similar worksheet is used for keeping
track of spouses, children, parents, next of kin and beneficiaries. A third database
worksheet is used to keep track of attorney time and services performed relative to the
wrongful death or minor’s claim.

2. What is the DEFAULT.WM5 file?
This topic explains the purpose of the DEFAULT.WM5 file and how to customize
the blank, start-up set of probate forms so that common information appears automatically when you select New from the File menu.

3. Using The Keyboard
This is a good topic to print because it summarizes all the keyboard shortcut commands in the program.

4. Overriding Answers
You will use this command when you need to manipulate entries in text input dialogs
that contain green colored texts.

5. Common Questions
If we get recurring questions about a particular facet of WMinor5 operation, you will
find the relevant help topic cited here.
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